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Foreword

ISO (the International Organization for Standardization) is a worldwide federation of national standards
bodies (ISO member bodies). The work of preparing International Standards is normally carried out
through ISO technical committees. Each member body interested in a subject for which a technical
committee has been established has the right to be represented on that committee. International
organizations, governmental and non-governmental, in liaison with ISO, also take part in the work.
ISO collaborates closely with the International Electrotechnical Commission (IEC) on all matters of
electrotechnical standardization.

The proce are
described i the [SO/IEC Directives, Part 1. In particular, the different approval criteria needed fof the
different types of ISO documents should be noted. This document was drafted in accordance with the
editorial rujes of the ISO/IEC Directives, Part 2 (see www.iso.org/directives).

Attention i drawn to the possibility that some of the elements of this document maybe the subjdct of
patent rights. ISO shall not be held responsible for identifying any or all such patent’rights. Detalls of
any patent rights identified during the development of the document will be in the Introduction and/or
on the ISO 1jst of patent declarations received (see www.iso.org/patents).

Any trade rlame used in this document is information given for the convehience of users and doe$ not
constitute gn endorsement.

For an explanation of the voluntary nature of standards, the -meaning of ISO specific terms|and
expressiong related to conformity assessment, as well as information about ISO's adherence tq the
World Trade Organization (WTO) principles in the TechnicalBarriers to Trade (TBT), see wwyv.iso
.org/iso/forleword.html.

This docurpent was prepared by Technical Commniittee ISO/TC 8, Ships and marine techndlogy,
Subcommittee SC 6, Navigation and ship operations.

Any feedbagk or questions on this document sheuld be directed to the user’s national standards bofy. A
complete ligting of these bodies can be found at www.iso.org/members.html.
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Introduction

On-board computer applications for safety and energy-efficient operations have become popular. These
applications require access to data of shipboard machinery and equipment.

To access data of navigational equipment, a data exchange standard, the IEC 61162 series can be
used. However, access of data from other on-board components and systems (e.g. machinery, safety
equipment and hull) have not yet been standardised.

Exchanging no name-based

n-standardised data between and/or among applications requires

aggregationandfo bpingHowaever-this reg a oflabe h-hinders the
use ¢f such data.

To iprove these situations, this document defines unified rules for developing mac¢hine and human-
readable identifiers and data structures for shipboard machinery and equipmentpwith the [objective to
faciljtate exchange and processing of sensor data from ships.

This|document defines two concepts and their models for data exchange: one is Data Chanjnel, and the
othelr is Time Series Data. This document thus defines two distinct datastructures and flile formats:
A Data Channel List, which contains the necessary meta-data, and\a’ Time Series Datal format for
meapurements. The time-series format is designed to be lightweightjand it therefore contajns minimal
metg-data information only in the form of a reference to the chafiniel list.

Datgd Channel is a concept that represents virtual data.transmission channels, and dgfines time-
invafriant properties. Data Channel can be viewed as a static description for the different sensor data
streams.

Datg Channel is composed of Data Channel ID and Data Channel Property.

Datq Channel ID uniquely identifies the logicaldata channels. Data Channel Property defings attributes
of Data Channel.

Thetfe are three types of Data ChannelID. One is Local ID, which is a unique identifier used on-board a
ship| and another is Universal ID, which is a universal identifier, composed of Name Entity, $hip ID (e.g.,
IMOnumbers) and Local ID. The ether ID is Short ID, a short alternative ID of Local ID.

The purpose of this documentis for exchanging data on-board a ship; however, in the futur¢, shipboard
machinery and equipmentimay be connected directly to the Internet.

Theiefore, consideringthe compatibility between Data Channel ID and URLs, which are useg to identify
datal on the Intermet;”Data Channel ID has a hierarchical structure with slashes as delimiters. To
represent a hierarehy, Data Channel is categorised in accordance with the standardised ¢ategorising
rulefand named\by concatenating these category names with slashes.

In AhnexesB and C, two types of categorising rules and example of codebook, lists of standardised
category'names given in accordance with the rules, are defined for reference.

They are not designed to unify Data Channel ID, but it is assumed that some entities will develop,
maintain and manage codebook and that they will be disclosed widely.

Data Channel Property is assumed to be used to automate data processing and help understanding of
data. Data Channel Property shall be used because it is considered to be essential to both computer
applications and humans for the reasons mentioned above.

Time Series Data is a concept that represents collection of time-stamped data. Time Series Data is
assumed to be used for sharing latest data and for analysing trends made over time-stamped data.

For reliable data exchange, this document mandates the use of XML (Extensible Markup Language)
and XML Schema for data encoding and data structure definition. Using XML and XML schemas makes
it possible to define data structures precisely and validate data in accordance with such definitions.
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As a result, it is believed that data can be exchanged more reliably between and/or among computer
applications.

Further, for convenience and efficiency, this document also defines data-structures in JSON and
CSV format.

It is assumed that data from shipboard machinery and equipment will be collected by shipboard data
servers, which are defined in ISO 19847. Then, the data encoded in accordance with this document, in
some cases, could be encrypted for security reasons, will be shared between and/or among computer
applications in a wide variety of means, such as in Hyper Text Transfer Protocol (HTTP), in Message
Queue Telemetry Transport (MQTT) or by e-mail through the servers. As described above, external
computer apptications Tanm Tetrieve on-poard data ummformiy by accessing the Servers:
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Ships and marine technology — Standard data for
shipboard machinery and equipment

1 Scope

This document applies to the structure of the ship and to shipboard machinery and equipment, and

is in
obje
For {
way

2

The
cong
unda

ISO
and

1S0/

W3( XML: Extensible Markup Language (XML)- 10, W3C Recommendation
W3({d XML Schema Part 1: XML Schema Part 12 Structures, W3C Recommendation
W3({ XML Schema Part 2: XML Schema:Part 2: Datatypes, W3C Recommendation

RFC
RFC
RFC

3 [erms and-definitions
For fhe purpases of this document, the following terms and definitions apply.

ISO gnddE€maintain terminological databases for use in standardization at the following a

3.1
aler

ended for 1mplementers of software used for the capture and processing of sensor,da
Cts mentioned above.

hose purposes, this document describes the way to name the sensor, required data it
to describe the data above.

Normative references
titutes requirements of this document. For dated referencesfonly the edition cited
B601, Data elements and interchange formats — Information interchange — Representa

times

[EC 80000 series, Quantities and units

3339, Date and Time on the Intérnet: Timestamps
4180, Common Format and MIME Type for Comma-Separated Values (CSV) Files
5234, Augmented BNF for Syntax Specifications: ABNF

ta from the

em, and the

following documents are referred to in the text in such a way that some or all of tleir content

hpplies. For

ited references, the latest edition of the referenced document.(including any amendments) applies.

tion of dates

ddresses:

/

ECEloctronedia- auvailahle at httn: //urururolactranoadia ar
HroEreetopetid—avahdue ittt P AAWSALEre et 6 P eaid-0+

%

n
P ot vVortT T TreTps/ \ =3

[SO Online browsing platform: available at https://www.iso.org/obp

t data

information that represents abnormal conditions of shipboard machinery and equipment

3.2

analogue data
numerical information obtained from sensors such as temperature sensors and pressure sensors

Note 1 to entry: Analogue data is a physical value converted from raw electric signals, such as 4-20 mA or 0-5 V.
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3.3
codebook
list of standardised names

3.4
data
measurement value from shipboard machinery and equipment to which a timestamp is added

3.5

Data Channel
virtual channel for data transmission from shipboard machinery and equipment to shipboard data
server, defifimgstatic propertiesof data

3.6
Data Channel ID
identifier fgr Data Channel that identifies Data Channel universally and on-board a ship

Note 1 to enffry: There are three types of Data Channel ID: Universal ID, Local ID and Short,ID.

3.7
Data Channel List
list of definiions for Data Channel that define Data Channel ID and Data Channel Property, and is shpred
through thd shipboard data server

3.8
Data Channel Property
attributes of Data Channel, such as units and ranges

39
Data Set
set of Data lhaving the same timestamp

3.10
ExtensibleMarkup Language
XML
text-based dlata description language uséd for exchanging data on the Internet

3.11
Hyper Text Transfer Protocol
HTTP
communicafion protocol used to exchange HTML (Hyper Text Markup Language) or other contemnt on
the Internef

3.12
IMO Number
unique refefence'number for ships that is given by the International Maritime Organisation (IMO)

3.13
logical structure
structure of data that is independent of physical implementation

3.14

measurement value

numeric value or a status symbol, produced as a result of measuring, calculating or estimating the state
of various objects

3.15
metadata
data that describes information about other data

2 © ISO 2018 - All rights reserved
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Name Object
building block of Data Channel ID used to define the hierarchical structure of Data Channel ID

3.17

Namespace

seto

3.18
Ship

)

f names that is used in order to avoid conflicts of names

board Data Server

«:

ship’s “information hub” that stores data from shipboard machinery and equipment, shares data at sea

inclu
Note

3.19

diTg Taciie data, arnd Sends Stored data outboard

1 to entry: See ISO 19847 for details.

shipboard machinery and equipment

varipus systems located in ships machinery space, such as main engine, genérator, pumps, fans, valves,
pipelines and electric control systems

3.20

statps data

information that represents the condition of shipboard machinefy and equipment
3.21

Timgp Series Data

colldction of a Data Set

3.22

XMI Schema

dataldefinition language used for XML

4 Abbreviated terms

ABN[F Augmented Backus.Naur Form

AMS Alarm Monitoring System

BNF Backus Naup Form

[AS Integrated Automation System

IMO [nternational Maritime Organisation

HIN Hull Identification Number

HT}\V L lIy lJCl TCAt }\V’{al }\up Lausuasc

HTTP Hypertext Transfer Protocol

RFC Request for Comments

SI The International Systems of Units

URI Uniform Resource Identifier

© ISO 2018 - All rights reserved 3
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UTC
UTF-8
XML

Universal Time Coordinated
UCS Transformation Format 8

Extensible Markup Language

5 Data Channel

5.1 General

Data Channgl is composed of Data Channel ID and Data Channel Property.

Data Chan

1 ID is an identifier for Data Channel, and Data Channel Property represents attribut

Data Channgl.

5.2 Data

Channel ID

There are three types of Data Channel ID:

Univers;

Local I

Short I]]
Universal I]]

Local ID, m
systems, su
their own D
to Local ID.

Short ID is

al ID;
D;
D.

is for identifying on-board Data Channel universadly.

panwhile, is for identifying on-board Data Channel locally. For instance, on-board comp
Ch as the Integrated Automation System (IAS)’and the Alarm Monitoring System (AMS),
ata Channel List, which is composed of unique Channel ID. This Channel ID can corresj

hin optional short alternative identifier of Local ID for usability and data compression.

short identiffier, for instance, can be used as Data Channel identifier in the Time Series Data format

Local ID an
These IDs s

NOTE D
Conversely,

1 Short ID shall be unique(for a ship.
hall be case-insensitive to avoid unexpected mistyping.

hta Channel of the-same kind of sensors on different ships is expected to have a same Loc
ven if Data Chahnel has a same meaning, Short ID may be different for each ship.

5.2.1 Universal ID

es of

uter
have
bond

This

h] ID.

Universal I]

The URI deffinition allows for many different compositions, but the Universal ID will be a subset of

isaan/URI conforming to the requirements below, in addition to those of the URI definition.

ese

and shall be in the following format.

Universal ID composition is defined by using Augmented BNF(ABNF), which is defined in RFC 5234, as

follows.

© ISO 2018 - All rights res

erved


https://standardsiso.com/api/?name=e2ddbc471cc9d5af12a4b3ee44601988

ISO 19848:2018(E)

UniversallD = [protocol] "//" NamingEntity ShipID LocallD
NamingEntity = authority
ShipID = path-element
path-element ="/"unreserved
path-elements = path-element | path-element path-elements
Defihition of the “Local ID” element is mentioned in 5.2.2.
The [‘authority” and “unreserved” element is defined in the URI definition. The “protecoll element is
optipnal.
NOTE1 Though path element of URI that is defined in RFC 3986 accepts muehmore characgers, such as
RFC B986 “sub-delimiters”, “”, “@”, etc., this document only accepts RFC 3986 “unreserved” chafacters since
thesg¢ characters may be used as control character in ISO 19847. (Definition of subydelimiters and unjreserved are
defirled in RFC 3986).
The glash (“/”) is a reserved character for describing hierarchies,
a) Naming Entity
Naming Entity element shall be a domain owned or eontrolled by the entity producing l.ocal ID.
EXAMPLE
— data.shipdatacenter.jp
— data.dnvgl.com
b) Phip ID
Ship ID is for identifying ships universally.
Jsually, an IMO number or-HIN should be used for Ship ID.
f ships have no IMO pumber or HIN, an identifier provided by countries or regions, or gther means
may be used instead-
EXAMPLE
— /IM01234567
— /]PsHXAB7A33G293
5.2.2 “Local ID

Local ID consists of Naming Rule and Local Data Name.

Local ID composition is defined by using ABNF as follows

© ISO 2018 - All rights reserved
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LocallD = NamingRule LocalDataName

NamingRule = path-element

LocalDataName = path-elements

path-element ="/"unreserved

path-elements = path-element | path-element path-elements

a) Naming Rule
Naming Rule shall be the designated name for the rule used to name Data Channel.

This name can be set freely under the supervision of Naming Entity, and shall have @ symbol|that
represgnts Naming Entity in front to eliminate duplications.

A Namnir)g Rule is a set of requirements that define a naming scheme (or anidentification schgme)
for compponents and systems on-board the ship. A Naming Rule shall .define how identification
stringsfare composed, and the method of developing an identification string.

EXAMPLE
— /jsthea_mac
— /dnvgl-vis

b) Local Data Name
Local Data Name is an identifier for Data Channel that is named in accordance with Naming Ryle.
The syntax of the identification string shall be disclosed and precisely defined using ABNF.
EXAMPLE
— /MainEngine/Cylinderl/ExhaustGas/Temp
— /41)1.1/C101.31+1/ExhGas+t(€)

5.2.3 ShdrtID

Short ID is|an optional-short alternative to Local ID. There must be a one-to-one correspondence
between Dgta Channel.and Short ID; Short ID shall therefore be unique for a ship.

Definition df Shortdb+s as follows.

ShortID = unreserved

Short ID shall be as short as practical and represented as machine-friendly symbols, human-friendly
short word, or a combination of those symbols and short word.

EXAMPLE
— 0001
— TAHO001

— ME_RPM

6 © ISO 2018 - All rights reserved
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5.2.4 Example of Data Channel ID

In the following example, Ship ID, Naming Rule and Local Data Name will be understood as the above
definition, but without the leading slash.

Universal ID http://data.shipdatacenter.jp/imo1234567/jsmea
mac/MainEngine/Cylinderl/ExhaustGas/Outlet/Temp

Local ID /jsmea_mac/MainEngine/Cylinderl/ExhaustGas/Outlet/ Temp

Short ID 0001

Ship ID imo1234567

Naming Entity data.shipdatacenter.jp o)

Narhing Rule jsmea_mac

Locpl Data Name  MainEngine/Cylinderl/ExhaustGas/Outlet/Temp O\‘ i

Universal ID http: .dnvgl.com/imo1234567/dnvgl-vis/411.1/€101.31+1/ExhGhs+t(C)

Locpl ID /dnvgl-vis/411.1/C101.31+1/ExhGas+t(C)

Shoft ID 0001 s

Shi;[ID imo1234567

Narping Entity data.dnvgl.com : ‘X\‘

Naming Rule dnvgl-vis

Lochl Data Name ~ 411.1/C101.31+1/ExhGas+t(C)2C

NOTE 1 It is not a requirement that the UniversalyID be a resolvable UR], i.e., the URI is not mecessarily a
valid URL.

5.3 | Data Channel Property

Datg Channel Property shall be defined to provide the attributes of Data Channel.
The feserved property types areas follows.

— Pata Channel Type

— Format

— Range

— Dnit

— [uality Coding

— Name
— Remarks
The properties above shall be described in accordance with the rules in this Clause.

Properties that are not listed above may be used if these are clearly distinguished from the properties
defined in the standard.

Details of each property are as follows.
a) Data Channel Type

Data Channel Type is used to identify the types of Data Channel, such as row numeric value, average
value, alarms and status. Data Channel Type is composed of the following sub-properties.

© ISO 2018 - All rights reserved 7
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— Type
— Update Cycle
— Calculation Period

Type sub-property defines type of Data Channel and the value of the property follows the definitions
mentioned in Table 1.

Table 1 — Type name of Data Channel Type

Frpe Deseription
Inst Measuring value at a certain point in time.
Average Average of the value within a certain time period.

"Average" does not mean average of values from multiple sensors at/the same fime
but average of time-series values from single sensor.

Max Maximum value within a certain time period.

"Maximum" does not mean maximum of values from multiple sensors at the game
time but maximum of time-series values from single sensor.

Min Minimum value within a certain time period.

"Minimum" does not mean minimum of values from multiple sensors at the Jame
time but minimum of time-series values frofiysingle sensor.

StandardDeviation Standard deviation of the value within a.certain time period.

"StandardDeviation" does not mean stahdard deviation of values from multiplefsen-
sors at the same time but standard deviation of time-series values from single sefisor.

Calculated Value obtained from calculationinstead of measurement.
SetPoint Target value for automatic control.

ControlOutyjut Manipulated value of autematic control.

Alert Alarm values that canbe obtained are also described.

Status Status values that.can be obtained are also described.
ManuallyInput Value input by \erew. Value assumed here is reading of indicator.

b)

Update|Cycle represents the cycle of updating measurement value. This sub-property shall be pised
when nmpeasurement value is(updated periodically.

When g value of Data CHamnel is a result of calculation that uses measurement value of specific|time
periodg, CalculationPeriod shall be used to describe the said period.

Update|Cycle and Calculation Period shall be described with a decimal number that is larger than
zero. The unitefUpdate Cycle and Calculation Period shall be the “second”.

Type syb=property is mandatory and the others are optional.

EXAMPLES

—  Type Average
— Calculation Period 60

— Update Cycle 1
Format

Format is used for describing data formats and defined by the following sub-properties.

— Type

— Restriction

© ISO 2018 - All rights reserved
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Type sub-property is mandatory and Restriction sub-property is optional. More than one
Restriction sub-property may exist under the Format property.

Available Types are as follows. Definitions of these data types comply with W3C XML Schema
Definition Language (XSD) 1.1 Part 2: Datatype.

Table 2 — Available Datatype for Format property

Type

Description

Decimal

Decimal represents a subset of the real numbers, which can be represented by

decimal numerals. The value space of decimal is the set of numbers

obtained by dividing an integer by a non-negative power of ten, i.e.,€3
i / 10n where i and n are integers and n 20. Precision is not refledted

space; the number 2.0 is not distinct from the number 2.00. The.ordef relation on

decimal is the order relation on real numbers, restricted to.this’subse

that can be
pressible as
n this value

t.

Integer

Integer is-derived-from decimal by fixing the value of fraetion digitd
disallowing the trailing decimal point. This results in(the standard m

to be 0 and
athematical

1,0,1,2,...}. The base type of integer is decimal.

concept of the integer numbers. The value space of integer is the infinjte set{...,-2,-

Boolean

Boolean represents the values of two-valued logic.

String

The string datatype represents character strings in XML.

Dat¢Time

YYYY indicates the year

MM indicates the month

DD indicates the day

T indicates the startof'the required time section
hh indicates the heur

mm indicates'the minute

ss indicates the second

Z indicates UTC

Date and time data types are used for&values that contain date and tirhe.

Format shall follow ISO 8601 "YYY¥Y-MM-DDThh:mm:ssZ" where:

Table 3 — Restrictions for Format property

Following restrictions, defined in W3C XML Schema are available to define acceptable values.
Validation rules and.available constraint for each data types shall follow W3C XML Sch¢ma.

Restriction Description Data Type
Enumeration Defines a list of acceptable values. string
FragqtionDigits Specifies the maximum number of decimal places allowed.| nonNegativelnteger
Must be equal to or greater than zero.
Length Specifies the exact number of characters or list items allowed. | nonNegativelnteger
Must be equal to or greater than zero.
MaxExclusive Specifies the upper bounds for numeric values (the value must| A value from the -value space-
be less than this value). of the {base type definition}.
MaxInclusive Specifies the upper bounds for numeric values (the value must| A value from the -value space-
be less than or equal to this value). of the {base type definition}.
MaxLength Specifies the maximum number of characters or list items|nonNegativelnteger
allowed. Must be equal to or greater than zero.
MinExclusive Specifies the lower bounds for numeric values (the value must| A value from the -value space-
be greater than this value). of the {base type definition}.
MinInclusive Specifies the lower bounds for numeric values (the value must| A value from the -value space-

be greater than or equal to this value).

of the {base type definition}.
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Table 3 (continued)

Restriction Description Data Type
MinLength Specifies the minimum number of characters or list items|nonNegativelnteger
allowed. Must be equal to or greater than zero.
Pattern Defines the exact sequence of characters that are acceptable. | string
TotalDigits Specifies the exact number of digits allowed. Must be greater | positivelnteger
than zero.
WhiteSpace Specifies how white space (line feeds, tabs, spaces, and car-

riage returns) is handled.

d)

10

EXAMPLES

— Type Decimal

— Regtriction TotalDigits 8, FractionDigits 3
Range
Range iis for describing Data Range. Range property is composed of thefollowing sub-propertips.
— Loy
— High

Low sup-property represents lower limit of the analogue<data, and High sub-property repredents
its uppér limit.

The valpe type of these sub-properties is decimal value or empty. The value of these sub-propefties
can be ¢mpty only if lower and/or upper limit.cannot be specified.

Further, High value must be greater than afnd not equal to Low value.
Range property is mandatory only of the'analogue data.

NOTE Range does not mean upper‘and lower boundary of the value. The value can exceed the range in
case of densor failure or other abriopmal condition.

EXAMPLES
— Loy O
— High 120
Unit

Unit defifies the unit and quantity applied to the measurement value. Unit property is composgd of
the following sub-properties.

— Unit Symbol
— Quantity Name

Unit symbols and quantity names defined in ISO 80000 or Table 4 shall be used for Unit Symbol and
Quantity Name sub-properties.

Unit Symbol sub-property represents unit symbol of the measurement value (e.g., “m” for length
and “kg” for mass). The value of Unit Symbol sub-property can be empty only for non-dimensional
quantities.

Quantity Name sub-property may be used to identify the variable that is measured or computed for
the physical item defined by the Data Channel.
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The measurement value shall be described according to the Unit defined in this property.

NOTE On-board computer applications (Data consumer) can convert Unit according to ISO
EXAMPLES

— Unit Symbol kW

— Quantity Name active power

— Unit Symbol Pa

—_ Quantity Name pressure

80000.

Table 4 — Additional units and quantities of measurement value

Quantity Name Unit Symbol Remarks
Cargo capacity TEU Twenty-foot Equivalent Unit
FEU Forty-foot Equiivalent Unit
e) [uality Coding

f)

g)

Duality Coding represents a name of data quality evaluationscheme and the scheme sh3
istinguish at least between valid and invalid measurement values of the Data Channel

EXAMPLES
— "OPC-QUALITY".
"IEC 61162-STATUS".

n the case of "I[EC 61162-STATUS",."A™(Data valid) and "V" (Data invalid) are used
uality.

Name

11 be able to

for the data

Name can be used to desctibe names assigned for on-board control systems and other ipstruments.

EXAMPLE
“Main Engine/Revolution”.
Remarks
n Remarks, arbitrary complementary information on Data Channel is described.

Rerharks should include locations, manufacturers and types of equipment.

XAMPLE

— “Location: ECR, Manufacturer: AAA Company, Type: TYPE-AAA”.

6 Time Series Data

6.1

General

Time Series Data is a collection of measurement values in which all the values have a corresponding
time of measurement. Usually such data is arranged and recorded in chronological order.

© ISO 2018 - All rights reserved
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6.2 Type of Time Series Data

For practical purposes (efficient data transport), two distinct representations of Time Series Data are

defined:

Tabular Data;

Event Data.

These representations are used depending on update interval of measurement values.

6.2.1 Ta

Tabular Dat
Channel Lis

Some exam
— multipl
result g

Measureme

1 Dai
uldil Dadtlta

bles of Tabular Data are:

Table 5 — Example of Tabular Data

a is a vector of a fixed number of values expected to be reported at regular interval.
t defines the interval.

e raw numeric values from sensors/transmitters sampled at the same time;
f the calculation (e.g. time average, standard deviation, etc.) to be.performed regularly.

nt values are grouped per timestamp, thus Tabular Data forms like Table 5.

Time Stamp Data Channel 1 | Data Channel 2_| Data Channel 3 | Data Channel 4
2017-p1-01T00:00:00Z 101.2 0.30 10.2 CLOSE
2017-p1-01T00:00:01Z 0.0 0.30 10.2 CLOSE
2017-p1-01T00:00:02Z 1109 032 10.2 OPEN

6.2.2 Event Data

Event Data
Some exam

alarm i

hformation;

manua

Event Data

status ilrformation;
I\

y input data;

bles of Event Data are:

fypically’ forms in tabular form like Table 6:

Table 6 — Example of Event Data by tabular form

s a collection of data for which the number of values at a specific time is not fixed.

Data

Time Stamp Data Channel 1 | Data Channel 2 | Data Channel 3 | Data Channel 4
2017-01-01T00:00:00Z 101.2 — — —
2017-01-01T00:00:01Z — — — —
2017-01-01T00:00:027Z 1109 0.32 — OPEN

Tabular form mentioned above is not efficient for Event Data, thus measurement values are grouped per
both timestamp and Data Channel ID and forms like Table 7:

12
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Table 7 — Example of Event Data

Time Stamp Data Channel ID Value
2017-01-01T00:00:00Z Data Channel 1 101.2
2017-01-01T00:00:02Z Data Channel 1 1109
2017-01-01T00:00:02Z Data Channel 2 0.32
2017-01-01T00:00:02Z Data Channel 4 OPEN

Time Series Data Composition

Each

Tabu
iden

row of Tabular/Event Data is called Data Set.

lar Data is composed of a collection of Data Set without Data Channel IDs, since v
Lified by its order.

hlue can be

Tabylar Data of Table 5 is described as follows.
DataSet("2017-01-01T00:00:00Z","101.2","0.30","10.2","CLOSE")
DataSet("2017-01-01T00:00:01Z","0.0","0.30","10.2","CLOSE")
DataSet("2017-01-01T00:00:02Z","110.9","0.32", "10.2","OPEN)

Event Data is composed of a collection of Data Set with Data Channel ID, since a number of values at a

spedific time cannot be fixed.

Evert Data of Table 7 is described as follows.

DataSet("2017-01-01T00:00:00Z ", "DataChannel1”, "101.2")
DataSet("2017-01-01T00:00:02Z ", "DataChannel1”, "110.9")
DataSet("2017-01-01T00:00:02Z ", "DataChannel2", "0.32")
DataSet("2017-01-01T00:00:02% ", "DataChannel4”, "OPEN")

7 Data structure

7.1 | General

Datd structuxe is the definition of logical structures that are independent from data imp]ementation

langpagesy/such as XML, JSON, CSV and others.

ThislCldause defines twag types of data structure. One is for Data Channel List the list of Dhta Channel

definitions in Clause 5, and the other is for serialisation and transport of Time Series Data in Clause 6.

These structures can be described by using XML, JSON and CSV.

In addition, standard data type, which is used to define the data structure and also independent of

impl

ementation languages, is defined.

Standard data type can be replaced with the data types defined in the implementation language.

Data implemented in accordance with the data structure can be shared between and/or among
computer applications.

© ISO 2018 - All rights reserved
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7.2

Implementation language

Data structure defined in this Clause shall be implemented in accordance with Annex A.

7.3 Standard data types

To define the data Structure, the following standard data types derived from UML primitive types
listed in Table 8 are used.

Table 8 — Standard data types

Standard data type Primitive type Restriction Remarks
Integer Integer
NonNegativelnteger Integer larger than -1
Positivelntejger Integer larger than 0
Real Real
Boolean Boolean
String String
DateTime String formatted by Refer to RFC3339for ABNF expression.

[SO 8601

Null Null specifies'the lack of a value (can be usef for

any datatypes).

7.4 Strug¢ture of Data Channel List

7.4.1 Datia model

Data Channgl List shall consist of the following fivé.elements.

a) Packag

Packag
which i

b) Header

Header
c¢) DataCh
DataCh|
DataCh
DataCh

h

hnnel

hnnellD

e) Property

b is a data package that is made up of Header, which is a set of metadata, and DataCha
5 a2 main data body.

indicates when Pata’Channel List is created and who creates it.

hnnel consists of Property and DataChannelld, which indicates Data Channel definitionis.

hnel,

[2)

Hr ertifi B - FtefiredHms=

Property defines the attributes of Data Channel defined in 5.3.

These elements are arranged in the hierarchic structure shown in Figure 1.

14
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Package

¢

1

Header

DataChannelList

7.4.7
Data

Dat3

H

L DataChannel

K

DataChannellD

Property

1

Figure 1 — Model of Data Channel List

. Logical structure
Channel List shall have the logical strtcture shown in Figure 2.

Channel List has a Package element. The Package element is composed of a He

ader and a

DatqChannelList element. The DataChannelList element includes one or more DataChannel elements

with

Furt

its IDs and properties.

her, NameObject elemenit may be added to define structure of Local ID.

© ISO 2018 - All rights reserved
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Package

Header: Header[1]
DataChannelList: DataChannelList{1]

Header Referenced by ConfigurationReference te
ShipID: String[1] TimeSeriesData.
DataChannelListID: ConfigurationReference ] ConfigurationReferenceis consist[Dand
Author: String{0..1] L TimeStamp element.
DateCreated : DateTime[0..1] ot o —
lue "DateCreated" is strings that comply
i Twiﬂusosaolfomm
: ConfigurationReference
1D String[1]
TimeStamp : DateTime[1]

DataChannelList
DataChannel: DataChannel[ 1. ]

DataChannel

DataChannelID: DataChannellD[1]
Property: Property[1]

DataChannellD
L _> LocallD : Stringf1]
ShortID: String[0..1]

NameObject: NameObject[0..1

|
| NameObject

Tz NamingRule:String[1]

Property

DataChannelType: DataChannelType[1]
——> Format: Format{1]

Range: Range[0..1]
Unit: Unit{0..1]
QualityCoding: String{0..1]
Name: String]0..1]
Remarks: String[0..1]
DataChannelType
L _> Type: String{1]
UpdateCyde: Real[0..1]
CalculationPeriod : Real[0..1
Format
= Type: Sting[1]
Restriction: Restriction|0..1]

Restriction

|

i

! Enumeration : Sring[0. ]

: FractionDigits: Integer{0..1]{value>-1}
|

|

|

|___> MaxLength : Integer{0..1{value>-1}
MinExdusive: Real[0..1]

MinIndusive:: Real[0..1]

MinLength : Integer{0..1{value>-1}

Pattem: String[0..1]

TotalDigits : Integer{0..1]{value>-0}

WhiteSpace : WhiteSpace[0..1]

Range

T ow:Real[1] ]| Valueof High/Lowelement
High: Real[1] *f~~~"]canbeempty.

Unit

> UnitSymbol:String[1] _ e}~———{ Valueof Unitelement
QuantityName: String[0..1] canbeempty.

Figure Z — Logical structure ol Data Channel List

Details of each element are described below.

a) Package structure

Name Data type Note Mandatory/ | Max

Option count
Header b) Header See b). Mandatory 1
DataChannelList d) DataChannelList See d). Mandatory 1
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Name Data type Note Mandatory/ | Max
Option count
ShipID String See 5.2.1. Mandatory 1
DataChannelListID c) ConfigurationReference See c). Mandatory 1
Author String Author of Data Channel |[Optional 1
List.
Dat¢Created DateTime Date when Packageis |Optional 1
created.
c) [onfigurationReference structure
Name Data type Note Mandatorffy/ | Max
Option count
ID String Identifier of Data Channel |Mandatory 1
List itself.
TimgStamp DateTime Modified Date & Fime. Mandatory 1
d) pataChannelList structure
Name Data type Note Mandatoyy/ | Max
Option count
Dat3aChannel e) DataChannel See e). Mandatory *
e) PataChannel structure
Name Data type Note Mandatory/ | Max
Option count
DataChannellD f) DataChannellD See f). Mandatory 1
Property g) Property See g). Mandatory 1
f) PataChannellD structure
Name Data type Note Mandatorfy/ | Max
Option count
LoclID String See 5.2.2. Mandatory 1
ShortID String See 5.2.3. Optional 1
NanjeObject m) NameObject Definition of Local Data Optional 1
Name structure.
g) Propertystraetare
Name Data type Note Mandatory/ | Max
Option count
DataChannelType h) DataChannelType See h) and 5.3 a). Mandatory 1
Format i) Format Seei)and 5.3 b). Mandatory 1
Range k) Range Seek)and 5.3 ). Mandatory* 1
Unit 1) Unit Seel) and 5.3 d). Mandatory* 1
*  Range and Unit are required only when Data Channel Type is “Decimal”.
© ISO 2018 - All rights reserved 17
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Name Data type Note Mandatory/ | Max
Option count
QualityCoding String 5.3e). Optional 1
Name String See 5.3f). Optional 1
Remarks String See 5.3 g). Optional 1
*  Range and Unit are required only when Data Channel Type is “Decimal”.
h) DataChannelType structure
Name Data type Note Mandatory/ | Max
Option cedunt
Type String Described in accordance Mandatory 1
UpdateCvecl Real with Data Channel Type Optional 1
pdateLyc ca format shown in 5.3 a). ptiona
CalculationReriod Real Optional 1
i) Format|structure
Ndme Data type Note Mandatory/ | Max
Option count
Type String Described in accordance Mandatory 1
Restriction j) Restriction }/Z)lrtn};:?tastl?o%\}/lr?rilr?g})).e Optional 1
i) Resfriction structure
Name Data type Note Mandatory/ | Max
Option count
Enumeratiop String Described in accordance Optional *
FractionDickt Int with Data Channel Type for- [ 0041 1
ractionDigjits nteger mat shown in 5.3 b) Table 3, ptiona
Length Integer Optional 1
MaxExclusiye Real Optional 1
MaxInclusive Real Optional 1
MaxLength Integer Optional 1
MinExclusiye Real Optional 1
MinInclusive Real Optional 1
MinLength Inteéger Optional 1
Pattern String Optional 1
TotalDigits Integer Optional 1
One of the following: Optional 1
“Preserve”
WhiteSpace
“Replace”
“Collapse”
k) Range structure
Name Data type Note Mandatory/ | Max
Option count
Low Real Lower limit of measuring range. Mandatory 1
High Real Upper limit of measuring range. Mandatory 1
18 © ISO 2018 - All rights reserved
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Name Data type Note Mandatory Max
/Option count
UnitSymbol String gr;g}:lﬂr:ll:lzlfefmed in 15080000 or Mandatory 1
QuaptieyN a Quantity name defined in ISO 80000or |, .. 1
lLl\.y INAITIC JUI llls 5.73 d) Table 4. Ul.l\.lullal

m) NameObject structure

Name Data type Note Mandatory/ | Max
Option count
NaningRule String See 5.2.2 Mandatory 1

7.5 | Structure of Time Series Data

7.5.1 Data model

Tim¢ Series Data shall consist of the following elements.

a) Package

main data body.

b) Header

br just formed by list of Short [Ds.

c¢) [[imeSeriesData

Clause 6.

Package element is data made up of a Header;which is a metadata, and TimeSeriesDatg, which is a

Header element contains the necessary metadata to link the Data in the Package fo the right
Channels in the Data Channel List'and the time in the real world.

[his can be achieved by infdicating when Time Series Data is created, who creates Time [Series Data,
hn explicit reference to'a specific Data Channel List, what Data Channels are included, the number
bf data and the measurement period of Time Series Data.

f such kind of nietadata is shared in advance by any means, Header element itself may| be omitted

[imeSeriesData element is a main body of the Package and contains Time Series Daty defined in

TimeSeriesData element also represents a group of DataSet and is grouped by Data Channel List
editions. Once Data Channel List is updated and the updates will affect the value of Time Series
Data, this element shall be newly generated.

d) TabularData

TabularData element contains a list of values defined in 6.2.

Tabular means that an ordered list of measurement value that is reported with the same timestamp

and the same update interval.

TabularData shall be grouped by the update interval.

© ISO 2018 - All rights reserved
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e) EventData

EventData element contains a list of (typically) irregularly updated values where a reference to the
Data Channel List (LocalID or ShortID) is given for each data point (see 6.2 for details).

(6) DataSet

DataSet is a set of measurement values having the same timestamp. There are two types of DataSet,
one is for TabularData, and the other is for EventData.

These elements are arranged in the hierarchic structure shown in Figure 3.

Package

1

$

Header

0.1

TimeSeriesData

1.* ‘

TabularData
0.*
1
DataSet
0.*
EventData
0.* ‘
1
DataSet
0.*

Figure 3 — Model of Time Series Data

7.5.2 Lo

fcal structure

Time Series Data shall have the logical structure shown in Figure 4.

Time Series Data has Package. Package has Header and TimeSeriesData. TimeSeriesData includes one
or more DataSet. DataSet has one TimeStamp and one or more Data.

20
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Package

Header : Header[0..1]

TimeSeriesData : TimeSeriesData[1..*]
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Header

ShipID : String[1]

TimeSpan : TimeSp;{n[O..l] Describe DateTime in accordance with ISO8601.Note that [N
L—> DataCreated : DateTime[0..1] definition of Date Time in XML Schema specification
DateModified : DateTime[0..1] references 1ISO8601.
Author : String[0..1]
SystemConfiguration : ConfigurationReference[0..*]
11 Reference to System configuration, such as OS, RDBMS. [N
If there is no SJIStemConfiguration element, the latest one
should be used.
TimeSpan
- Start: DateTime[1] oJ__ } N
. i ] 7 Describe DateTime in accordance wit] . Not
End: DateTime[1] e 1D ibe DateTime i d ith ISO8601. Ni
~~7 definition of Date Time in XML Schema specificatim}\
references ISO8601.
(@)
TimeSeriesData When DataChannelList is modified, ne %eSeriesData” [AN
_ | element will be created. ‘h
| _~J DataConfiguration : ConfigurationReference[0..1] e~ | If there is no DataConfiguration ele% , the latest one shquld
TabularData : TabularData[0..%] be used. q
EventData : EventData[0..1] N,

NumberOfDataSet : Integer[0..1]{value>-1}
DataSet : DataSet _Event[0..*]

"TabularData" elements are
One of these should be included ] TabularData grouped per update |nterval.
under TimeSeriesData element. S ——
NumberOfDataSet : Integer([0..1]{value>-1}
\\\ NumberOfDataChannel : Integer[0..1}{value>-1}
\\ DataChannellD : String[0..*] .
D :D Tabular[0.* N
ataSet : DataSet _Tabular[0.7] ~~o Order of DataChannelID
~~~_|and Value arthy should
N be the same.
AN Otherwise, | ieference No.
AN DataSet_Tabular shall be addefl to each
AN element of
o @ TimeStamp : DateTime[1] ~1DataChannell]D / Value
N ~~"| Value: String[1.*] ® array.
\\ que. Quality : String[0..1]
N\,
N\,
\\\ S~
N\, \\
EventData =
Grouped per [[imeStamp

ConfigurationReference DataSet_Event Grouped per FimeStamplj
" ~71and DataCharjnellD
ID : String[1] TimeStamp : DateTime[1]
TimeStamp : DateTime[1] DataChannellD : String[1]
Value : String[1]
Quality : String[0..1]
Figure 4 — Logical structure of Time Series Data
Detgils of each element are as follows.
a) Package structure
Name Datatype Note Mandatory/ | Max
Option count
Header b) Header See b). Optional 1
For periodic data exchange,
this element can be omitted to
reduce data size.
TimeSeriesData e) TimeSeriesData See e). Mandatory  |*
TimeSeriesData is grouped by
DataChannelList editions.

© ISO 2018 - All rights reserved

21


https://standardsiso.com/api/?name=e2ddbc471cc9d5af12a4b3ee44601988

ISO 19848:2018(E)

b) Header structure

Name Data type Note Mandatory/ | Max
Option count
ShipID String IMO number, HIN, etc. Mandatory 1
TimeSpan c) TimeSpan See c). Optional 1
DateCreated DateTime Date when Package is created. |Optional 1
DateModified DateTime Date when Package is modified. |Optional 1
Author String Author of data. Optional 1
SystemConffguration d) ConfigurationReference | See d). Optional *
Reference to the configuration of
systems, such as OS, RDBMS, etc.
c¢) TimeSpan structure
Name Data type Note Mandatory/ | Max
Option cqunt
Start DateTime Timestamp of the oldest Data Mandatory 1
Set.
End DateTime Timestamp of the newest Data |Mandatory 1
Set.
d) ConfigyrationReference structure
Name Data type Note Mandatory/ | Max
Option cqunt
ID String Identifier of the configuration. |Mandatory 1
TimeStamp DateTime Modified date & time of the Mandatory 1
configuration.
e) TimeSeriesData structure
Name Data type Note Mandatory/ | Max
Option cqunt
DataConfigyration d)€onfigurationReference | See d). Optional 1
Reference to the DataChannel-
List.
If there is a no reference, the
latest DataChannelList shall be
used.
TabularData fJ TabularData SeeT)and Clause 6. Optional *
EventData g) EventData See g) and Clause 6. Optional 1

22
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Name Data type Note Mandatory/ | Max
Option count
NumberOfDataSet NonNegativelnteger Number of DataSet in the Tabu- |Optional 1
larData element.
NumberOfDataChannel |NonNegativelnteger Number of DataChannel in the |Optional 1
TabularData element.
DatgChanreHb String Array-ofene-ofthe Data-ChannelOptional *
ID in 5.2.
Order of DataChannellD ele-
ments shall be same as f) Tabu-
larData/Value.
If the order of DataChannellDyel
ements cannot be specified, ref-
erence number shall beladded.
Further, If the order of Data-
ChannellD elements can be fixed
and never chahged, these ele-
ments may-beomitted.
DatgSet h) DataSet_Tabular See Clause 6. Optional *
g) EventData structure
Name Data type Note Mandatqry/ | Max
Option count
NunpberOfDataSet NonNegativelnteger Number of DataSet in the Event- |Optional 1
Data element.
DataSet i) DataSet_Ewvent See 6.3 b). Optional *
h) PataSet_Tabular structure
Name Data type Note Mandatqry/ | Max
Option count
Timgstamp DateTime Time of measurement. Mandatorfy 1
Value String Array of measurement value of |Mandatorfy |*
each data channel at TimeStamp.
Order of Value elements shall be
same as f) TabularData/Data-
ChannellD.
If the order of Value elements
cannot be specified, reference
number shall be added.
Quality String Data quality of the Value above. |Optional 1
i) DataSet_Event structure
Name Data type Note Mandatory/ | Max
Option count
Timestamp DateTime Time of measurement. Mandatory 1
DataChannellD String One of the Data Channel ID in 5.2.| Mandatory 1
Value String Measurement value. Mandatory 1
Quality String Data quality of the Value above. |Optional 1
© IS0 2018 - All rights reserved 23
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Annex A
(Normative)

Implementation

A.1 General

A.1.1 Exc

Data which

Regardless

XML/JSON

(*: contains

validation

communica

Series Data

exchanging

A.1.2 Exo

The data fil

To do this, t

The na

A.2 XML|implementation

A.2.1 General

In this Clause, requirements are shown of cases in which the data formats discussed in Clause

Data shi

The name of the file shall not startwith “” (period).

The name of the file shall not codtain [\ ][ /1[:1[*T1[?]1["1[<]1[>11]]and any white s
charactlers.

The length of the name. efithe file shall be less than or equal to 255 characters.

hanging Data

have structure as written in Clause 8, will be implemented by XML, JSON or GSV.
pf the implementation language, data shall comply as follows.

all be written by text and encoded by UTF-8 WITHOUT Byte Order Mark (BOM).

is recommended to exchange Data Channel List and snap shot(*) of Time Series
single Data Set or a few number of Data Sets). When usingJSON, since there is no sch
mechanism, it is recommended to develop applications¢with an environment that
ke with actual shipboard data server. CSV is recommended for especially large
In this case, Data Channel List shall be shared in advance. XML/JSON is recommende
Data Channel List.

hanging data as a file
e shall be designed to be able to process invarious file systems.

he file shall comply with the following requirements.

e of the file shall be case-insenSitive.

Data
ema
can

Time

1 for

pace

implemented with the use of XML and XML Schemas.

XML Schem

EXAMPLE

24

a is formulated in accordance with the rules described below.

The minimum and maximum numbers of occurrences shall be defined.

<nr:NamingRule nr:ID="Naming_Rule"/>

Naming Rule specific elements and attributes should belong to its own Namespace.

Any newline or indent characters in the file shall not be treated as significant information.
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A.2.2 Standard & XML Schema data type
Standard data type in 7.3 is replaced with XML Schema data type in Table A.1.

Table A.1 — Correspondences between standard data type and XML Schema data type

Standard Data Type XML Schema Data Type Note

Integer Integer Integer number

Positivelnteger Positivelnteger Integer number thatis 1 or larger

NonNegativelnteger NonNegativelnteger Integer number thatis 0 or larger

Rea Decimal Decimal number

Dat¢Time DateTime [SO 8601 time and date

CharacterString String Random string of characteérs

Boolean Boolean Truth value

Null XML Schema When designating Null, designdte Attribute
<element name="example" tvpe="float" nillable="true” in the Element flefinition of
nillable="true" ; p ype= XML Schema,and Attribute nillaple="true” in

- the corresponding Elementin XML Document.

XML Document
<example nil="true"/>

A.2.3 Data Channel List
a) Namespace

[he following Namespace shall be added to allithe elements and attributes in Data Channel List.
XMLNamespace:sdd = urn:ISO019848:Ship_Data_Definition
n case of using Naming Rule specific;elements/attributes, namespace shall be to avoid duplication.
EXAMPLE XMLNamespace:nr =urn:1S019848:Ship_Data_Definition:Naming_Rule

b) KML Schema

Pata structures in 7.4-shall be defined and validated by using following XML Schema.
<2xnfl version="1.0"‘entoding="utf-8"2>

<xs:lschema xmlns;sd@="urn:IS019848:SHIP DATA DEFINITION"
attraputeFormDefault="unqualified" elementFormDefault="qualified"

targ€tNamespace="urn:15019848:SHIP DATA DEFINITION"
zxmlns:xs="http://www.w3.0rg/2001/XMLSchema">

<![--7.4%2 a) Package structure-->
<xls :€lement name="Package" type="sdd:Package"/>

<I==T7.4.7 &) Package structure--
<xs:complexType name="Package">
<xs:sequence>
<!--7.4.2 b) Header structure-->
<xs:element name="Header" type="sdd:Header" minOccurs="1" maxOccurs="1"/>
<!--7.4.2 d) DataChannellist structure-->
<xs:element name="DataChannellList" type="sdd:DataChannellList" minOccurs="1"
maxOccurs="1"/>
</xs:sequence>
</xs:complexType>

<!--7.4.2 b) Header structure-->
<xs:complexType name="Header">
<xs:sequence>
<!--IMO Number, HIN or other ship's identification number-->
<xs:element name="ShipID" type="xs:string" minOccurs="1" maxOccurs="1"/>

© IS0 2018 - All rights reserved 25


https://standardsiso.com/api/?name=e2ddbc471cc9d5af12a4b3ee44601988

ISO 19848:2018(E)

<!--Identifier of this list-->

<xs:element name="DataChannelListID" type="sdd:ConfigurationReference"
minOccurs="1" maxOccurs="1"/>

<!--Author of data-->

<xs:element name="Author" type="xs:string" minOccurs="0" maxOccurs="1"/>

<!--Date when data are created-->

<xs:element name="DateCreated" type="xs:dateTime" minOccurs="0" maxOccurs="1"/>

<!--Extension point for custom headers-->
<xs:any processContents="1lax" namespace="##other" minOccurs="0"
maxOccurs="unbounded" />
</xs:sequence>
</xs:complexType>

<!__7.4._ ) \/Ulllik:juLdLJ’.ULlI\CLCLCMLC o LLUCLULTT™
<xs:complexType name="ConfigurationReference">
<xs:sefjuence>
<xs:plement name="ID" type="xs:string" minOccurs="1" maxOccurs="1"/>
<xs:plement name="TimeStamp" type="xs:dateTime" minOccurs="1" maxOccurgs"1"/>
</xs:spquence>
</xs:complexType>

<!--7.4.p d) DataChannellist structure-->
<xs:complexType name="DataChannelList">
<xs:sefjuence>
<!--J.4.2 e) DataChannel structure-->
<xs:plement name="DataChannel" type="sdd:DataChannel" minOccurs="1"
maxOccurs=[|"unbounded" />
</xs:sgquence>
</xs:complexType>

<!--7.4.p e) DataChannel structure-->
<xs:compllexType name="DataChannel">
<xs:sefjuence>
<!--).4.2 f) DataChannelID structure-->
<xs:plement name="DataChannelID" type="sddi\PataChannelID" minOccurs="1"
maxOccurs=["1"/>
<!--V.4.2 g) Property structure-->
<xs:plement name="Property" type="sdds«Property" minOccurs="1" maxOccurs="1"/>
</xs:spquence>
</xs:complexType>

<!--7.4.p f) DataChannellID structure-->
<xs:complexType name="DataChannelID">
<xs:sefjuence>
<xs:plement name="LocalTD" type="xs:string" minOccurs="1" maxOccurs="1"/>
<xs:fplement name="ShdrztID" type="xs:string" minOccurs="0" maxOccurs="1"/>
<!--F.4.2 m) NameOpijelt structure-->

<xs:plement namez"NameObject" type="sdd:NameObject" minOccurs="0" maxOccurs="1"/

</xs:sgquence>
</xs:complexType>

<!--7.4.p g) Preperty structure-->
<xs:complexPype name="Property">
<xs:sefjpence>
<!--p.3/a) Identifier of Data Channel Tvpe, such as raw numeric value,

average value, alarm and status, etc.-->
<xs:element name="DataChannelType" type="sdd:DataChannelType" minOccurs="1"
maxOccurs="1"/>
<!--5.3 b) Formats are for describing data formats-->
<!--Assumed data types are "Float","Integer","Boolean","Text" and "Symbol"-->
<xs:element name="Format" type="sdd:Format" minOccurs="1" maxOccurs="1"/>

<!--5.3 c) Range of measurement value-->

<xs:element name="Range" type="sdd:Range" minOccurs="0" maxOccurs="1"/>
<!--5.3 d) Unit and quantity of measurement value-->

<xs:element name="Unit" type="sdd:Unit" minOccurs="0" maxOccurs="1" />
<!--5.3 e) Name of data quality evaluation scheme-->

<xs:element name="QualityCoding" type="xs:string" minOccurs="0" maxOccurs="1"/>

<!--5.3 f) Names assigned in on-board control systems and other instruments-->
<xs:element name="Name" type="xs:string" minOccurs="0" maxOccurs="1"/>

<!--5.3 g) Remarks shall contains location, manufacturer and type of equipment-->

<xs:element name="Remarks" type="xs:string" minOccurs="0" maxOccurs="1"/>
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<!--Extension point for custom properties—-->
<xs:any processContents="lax" namespace="##other" minOccurs="0"
maxOccurs="unbounded" />
</xs:sequence>
</xs:complexType>

<!--7.4.2 h) DataChannelType structure-->
<!--5.3 a) Identifier of Data Channel Type, such as raw numeric value,
average value, alarm and status, etc.-->
<xs:complexType name="DataChannelType'">
<xs:sequence>
<xs:element name="Type" minOccurs="1" maxOccurs="1">
<xs:simpleType>
b.LCbL,LJ‘.LL,J‘_UlL Dadsc— b.bLLJ‘_llk_.j
<xs:enumeration value="Inst"/>
<xs:enumeration value="Average"/>
<xs:enumeration value="Max"/>
<xs:enumeration value="Min"/>
<xs:enumeration value="StandardDeviation"/>
<xs:enumeration value="Calculated"/>
<xs:enumeration value="SetPoint"/>
<xs:enumeration value="Output"/>
<xs:enumeration value="Alert"/>
<xs:enumeration value="Status"/>
<xs:enumeration value="ManuallyInput"/>
</xs:restriction>
</xs:simpleType>
</xs:element>
<xs:element name="UpdateCycle" type="xs:decimal"*minOccurs="0" maxOccurs="[1"/>
<xs:element name="CalculationPeriod" type="xshdecimal" minOccurs="0" maxOclcurs="1"/>
</xs:sequence>
</Igs:complexType>

<l|--7.4.2 i) Format structure-->
<!I--5.3 b) Format of measurement value-$&
<¥s:complexType name="Format">
Xs:sequence>
<!--Type of the Format-->
<xs:element name="Type" min@eeturs="1" maxOccurs="1">
<xs:simpleType>
<xs:restriction basge="xs:string">
<xs:enumeration «waltue="Decimal"/>
<xs:enumeratiof yalue="Integer"/>
<xs:enumeration value="Boolean"/>
<xs:enumer@tion value="String"/>
</xs:restrietifon>
</xs:simpleType>
</xs:elemepts
<!==7.4.2°)3) Restriction of the value-->
<xs:eleffent name="Restriction" minOccurs="0" maxOccurs="1">
<xsé{complexType>
<®s:choice maxOccurs="unbounded">
<xs:element name="Enumeration" type="xs:string" minOccurs="0"
maxQceurs="unbounded" />
<xs:element name="FractionDigits" type="xs:integer" minOccurs="0"
maxOccurs="1"/>
<xs:element name="Length" type="xs:integer" minOccurs="0" maxOccurs="1"/>
<xs:element name="MaxExclusive" type="xs:decimal" minOccurs="0"
maxOccurs="1"/>
<xs:element name="MaxInclusive" type="xs:decimal" minOccurs="0"
maxOccurs="1"/>
<xs:element name="MaxLength" type="xs:integer" minOccurs="0" maxOccurs="1"/>
<xs:element name="MinExclusive" type="xs:decimal" minOccurs="0"
maxOccurs="1"/>
<xs:element name="MinInclusive" type="xs:decimal" minOccurs="0"
maxOccurs="1"/>
<xs:element name="MinLength" type="xs:integer" minOccurs="0" maxOccurs="1"/>
<xs:element name="Pattern" type="xs:string" minOccurs="0" maxOccurs="1"/>
<xs:element name="TotalDigits" type="xs:integer" minOccurs="0" maxOccurs="1"/>
<xs:element name="WhiteSpace" minOccurs="0" maxOccurs="1">
<xs:simpleType>
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<xs:restriction base="xs:string">
<xs:enumeration value="preserve"/>
<xs:enumeration value="replace"/>
<xs:enumeration value="collapse"/>
</xs:restriction>
</xs:simpleType>
</xs:element>

</xs:choice>

</xs:complexType>

</xs

relement>

</xs:sequence>
</xs:complexType>

<!-=7.4.
<!--5.3
<Xs:comp

<xs:se
<!--
<xs:
<!P--
<xs:
</xs:s
</xs:com

<!-=7.4.
<!--5.3

<xs:comp

<xs:se

<!l--

<xXs:

<!--

<XS:

<!l--

etc.—-——>

<XS:

maxOccurs=

</xs:s

</xs:com

<!-=7.4.
<xs:comp
<xXs:se
<!--

<xs:

<!--

<xXs:
maxOccurs=
</xs:s
</xs:com

<!--empt
<xs:simp

<xs:un
</xs:sim
<xs:simp

PR
) Range of measurement value-->

l exType name="Range">

huence>

Higher limit of measurement value-->

Element name="High" type="sdd:emptyOrDecimal”™ minOccurs="1" maxOccurs="1"/>
[ower limit of measurement value-->

Element name="Low" type="sdd:emptyOrDecimal" minOccurs="1" max@ccurs="1"/>
Equence>

blexType>

RdAllge SLLUCLULTS™™

P 1) Unit structure-->

H) Unit and quantity of measurement value-->

lexType name="Unit">

huence>

Eymbol of the unit-->

Element name="UnitSymbol" type="xs:string" minOl¢urs="1" maxOccurs="1"/>
Duantity name of the measurement value, that,is' defined in IS080000 or Table2
Element name="QuantityName" type="xs:string/\minOccurs="0" maxOccurs="1"/>
Fxtension point for custom Unit element, su€h as Quantity Symbol, Scale Fact

bny processContents="lax" namespace="#%ether" minOccurs="0"
'unbounded" />

Equence>

blexType>

P m) NameObject structure-->

lexType name="NameObject">

huence>

Name of NamingRule, seé 5.2.3-->

Element name ="NamindRule" type="xs:string" minOccurs="1" maxOccurs="1"/>
Fxtension point for ‘¢ustom NameObjects, Definition of LocalDataName structure
bny processContents="1lax" namespace="##other" minOccurs="0"

'unbounded" />

Equence>

blexType>

y value<adceptable decimal-->

| eTypesname="emptyOrDecimal">

i on smemberTypes="sdd:empty xs:decimal"/>
b leType>

leTYpe name="empty">

br,

<xs:restriction base="xs:string">
<xs:enumeration value=""/>
</xs:restriction>
</xs:simpleType>
</xs:schema>

c¢) XML representation

This example uses namespace:nr for custom elements. Custom elements are written in Italic for
reference.

<?xml version="1.0" encoding="utf-8"?>
<Package xmlns="urn:I1S019848:SHIP DATA DEFINITION"
xmlns:nr="urn:15019848:SHIP DATA DEFINITION:NAMING RULE">

<Header>

<ShipID>IM01234567</ShipID>
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<DataChannelListID>
<ID>DataChannellList.xml</ID>
<TimeStamp>2016-01-01T00:00:00Z</TimeStamp>
</DataChannellistID>
<Author>Authorl</Author>
<DateCreated>2015-12-01T00:00:00+00:00</DateCreated>
<nr:CustomHeaderElement>Vender specific headers</nr:CustomHeaderElement>
</Header>
<DataChannelList>
<DataChannel>
<DataChannelID>
<LocalID>/Naming Rule/MainEngine/AirCoolerl/CoolingFreshWater/Outlet/Temp
</LocallD>
QIO U LD UUlU QIO U LD
<NameObject>
<NamingRule>Naming rule</NamingRule>
<nr:CustomNameObject>Vender specific NameObject</nr:CustomNameObjgct>
</NameObject>
</DataChannelID>
<Property>
<DataChannelType>
<Type>Inst</Type>
<UpdateCycle>1</UpdateCycle>
</DataChannelType>
<Format>
<Type>Decimal</Type>
<Restriction>
<FractionDigits>1</FractionDigits>
<MaxInclusive>200.0</MaxInclusive>
<MinInclusive>-150.0</MinInclusive>
</Restriction>
</Format>
<Range>
<High>150.0</High>
<Low>0.0</Low>
</Range>
<Unit>
<UniltSymbol>°C</UnitSymbol>
<QuantityName>Temperatures/QuantityName>
</Unit>
<QualityCoding>0PC_QUALILTY</QualityCoding>
<Name>M/E #1 Air Cooler CFW OUT Temp</Name>
<Remarks> Locationt ECR, Manufacturer: AAA Company, Type: TYPE-AAA </Remarks>
<nr:CustomPropertyElement>Vender specific Property</nr:CustomPropertyElement>
</Property>
</DataChannel>
<DataChannel>
<DataChanng™IP>
<LocalXD>/Naming Rule/MainEngine/AirCoolerl/CoolingFreshWater/Outlet/Prefss
</LocallD>
<ShértID>0020</ShortID>
<NameObject>
<NamingRule>Naming Rule</NamingRule>
<nr:CustomNameObject>Vender specific NameObject</nr:CustomNameObject>
</NameObject>
</DataChannelID>
<Property>
<DataChannelType>
<Type>Average</Type>
<UpdateCycle>60</UpdateCycle>
<CalculationPeriod>3600</CalculationPeriod>
</DataChannelType>
<Format>
<Type>Integer</Type>
<Restriction>
<FractionDigits>1</FractionDigits>
<MaxInclusive>200.0</MaxInclusive>
<MinInclusive>-150.0</MinInclusive>
</Restriction>
</Format>
<Range>
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<High>150.0</High>
<Low>0.0</Low>
</Range>
<Unit>
<UnitSymbol>°C</UnitSymbol>
<QuantityName>Temperature</QuantityName>
</Unit>
<QualityCoding>0OPC QUALITY</QualityCoding>
<Name> M/E #1 Air Cooler CFW OUT Average Temp </Name>
<Remarks> Location: ECR, Manufacturer: AAA Company, Type: TYPE-AAA </Remarks>
<nr:CustomPropertyElement>Vender specific Property</nr:CustomPropertyElement>
</Property>
</DataChannel>
<DataCjrarret
<DatpChannelID>
<LpcalID>/Naming Rule/MainEngine/AirCoolerl/CoolingFreshWater/Outlet/Temp/Alerf
</LocallD>
<ShortID>0011</ShortID>
<NpmeObject>
NamingRule>Naming Rule</NamingRule>
nr:CustomNameObject>Vender specific NameObject</nr:CustomNameObject>
</NameObject>
</DafaChannelID>
<Property>
<DptaChannelType>
Type>Alert</Type>
</pataChannelType>
<Fprmat>
Type>String</Type>
Restriction>
<Enumeration>High</Enumeration>
<Enumeration>Low</Enumeration>
<Enumeration>Normal</Enumeration>
/Restriction>
</Format>
<QpalityCoding>0OPC QUALITY</QualityCoding>
<Npme> M/E #1 Air Cooler CFW OUT Temp~Status </Name>
<Rpmarks> Location: ECR, Manufactuwer: AAA Company, Type: TYPE-AAA </Remarks>
<nf:CustomPropertyElement>Vendersspecific Property</nr:CustomPropertyElement>
</Prpperty>
</Datafhannel>
<DataChannel>
<DatpChannelID>
<LpcalID>/Naming Rule/MainEngine/AirCoolerl/CoolingFreshWater/Outlet/Press/Aleft
</LocallD>
<ShortID>0021</ShoxEiD>
<NpmeObject>
NamingRule>Nami#hg Rule</NamingRule>
nr:CustomNameObject>Vender specific NameObject</nr:CustomNameObject>
</NameObject>
</DafaChann&l iD>
<Property>
<DhtaChehnelType>
Type>Alert</Type>
</patéChannelType>
<Format>
<Type>String</Type>
<Restriction>
<Enumeration>High</Enumeration>
<Enumeration>Low</Enumeration>
<Enumeration>Normal</Enumeration>
</Restriction>
</Format>
<QualityCoding>0OPC QUALITY</QualityCoding>
<Name> M/E #1 Air Cooler CFW OUT Press Status </Name>
<Remarks> Location: ECR, Manufacturer: AAA Company, Type: TYPE-AAA </Remarks>
<nr:CustomPropertyElement>Vender specific Property</nr:CustomPropertyElement>
</Property>
</DataChannel>
</DataChannellList>
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</Package>

A2.4 Time Series Data

a) Namespace
In Time Series Data, the following Namespace shall be added.
XMLNamespace:sdt=urn:IS019848:Ship_Data_Transport

b) XML Schema

Pata structures in 7.5 shall be defined and validated by using following XML Schema

<?xnml version="1.0" encoding="utf-8"?>

<xs:lschema xmlns:sdt="urn:IS019848:SHIP DATA TRANSPORT"
attributeFormDefault="unqualified" elementFormDefault="qualified"
targetNamespace="urn:15019848:SHIP DATA TRANSPORT"
xmlns:xs="http://www.w3.0rg/2001/XMLSchema">

<!--8.4.2 (1) Package structure-->
<xls:element name="Package" type="sdt:Package"/>

<!--8.4.2 (1) Package structure-->

<¥s:complexType name="Package">

<xs:sequence>

<!--8.4.2(2) Header structure-->

<xs:element name="Header" type="sdt:Header"
minOccurs="0" maxOccurs="1"/>

<!--8.4.2(5) TimeSeriesData structure -->

<xs:element name="TimeSeriesData" type="odt:TimeSeriesData"
minOccurs="1" maxOccurs="unbounded" />

</xs:sequence>

</lxs:complexType>

<!--8.4.2(2) Header structure-->

<¥s:complexType name="Header">

<xs:sequence>

<!--IMO Number, HIN or otheft ship's identification number-->

<xs:element name="ShipID! "type="xs:string"
minOccurg="I" maxOccurs="1"/>

<!--8.4.2(3) TimeSpan-structure-->

<xs:element name=z=!TimeSpan" type="sdt:TimeSpan"
mipOgcurs="0" maxOccurs="1"/>

<!--Date whensdata are created-->

<xs:element mwame="DateCreated" type="xs:dateTime"
minOccurs="0" maxOccurs="1"/>

<!--Date_When data are modified-->

<xs:eleméent name="DateModified" type="xs:dateTime"
minOccurs="0" maxOccurs="1"/>

<!+sAuthor of data-->

<xstelement name="Author" type="xs:string"
minOccurs="0" maxOccurs="1"/>

==8.4.2(4) RELcrence TO SysStem coniiguracion --

<xs:element name="SystemConfiguration" type="sdt:ConfigurationReference"
minOccurs="0" maxOccurs="unbounded" />

<!--Extension point for custom headers-->

<xs:any processContents="lax" namespace="##other" minOccurs="0"

maxOccurs="unbounded" />

</xs:sequence>
</xs:complexType>

<!--8.4.2(3) TimeSpan structure-->
<xs:complexType name="TimeSpan">
<xs:sequence>
<!--TimeStamp of the oldest DataSet-->
<xs:element name="Start" type="xs:dateTime" minOccurs="1" maxOccurs="1"/>
<!--TimeStanp of the newest DataSet-->
<xs:element name="End" type="xs:dateTime" minOccurs="1" maxOccurs="1"/>
</xs:sequence>
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</xs:complexType>

<!--8.4.2(4) ConfigurationReference structure-->
<xs:complexType name="ConfigurationReference">
<xs:sequence>
<xs:element name="ID" type="xs:string" minOccurs="1" maxOccurs="1"/>
<xs:element name="TimeStamp" type="xs:dateTime" minOccurs="1" maxOccurs="1"/>
</xs:sequence>
</xs:complexType>

<!--DataChannelID structure-->
<!--Value must be Local ID or Shor ID strings. see 6.1 for the details.-->
<xs:complexType name="DataChannelID">
<xs:si MO LCCOIICeIIC
<xs:pxtension base="xs:string">
<!F-Ordinal number of the DataChannelID array-->
<xp:attribute name="id" type="xs:positivelnteger" use="required" />
</xsfextension>
</xs:sfimpleContent>
</xs:complexType>

<!--8.4.P(5) TimeSeriesData structure -->
<xs:complexType name="TimeSeriesData">
<xs:sefjuence>
<!--B.4.2(4) ConfigurationReference structure -->
<xs:plement name="DataConfiguration" type="sdt:ConfigurationReference"
minOccurs="0" maxOccurs="1" />
<!--B.4.2(6) TabularData structure -->
<xs:fplement name="TabularData" type="sdt:TabularData"
minOccurs="0" maxOccurs="unbounded" /X
<!--B.4.2(7) EventData structure -->
<xs:plement name="EventData" type="sdt:EventData!
minOccurs="0" maxOccurs="1" />
<!--Extension point for custom data kinds-->
<xs:pny processContents="lax" namespace="#%ether" minOccurs="0"
maxOccurs=|"unbounded" />
</xs:sgquence>
</xs:complexType>

<!--8.4.P(6) TabularData structure -%>
<xs:compllexType name="TabularDatal>
<xs:sefjuence>
<!--Number of DataSet eleménts under the hierarchy -->
<xs:plement name="NumberOfDataSet" type="xs:nonNegativeInteger"
minOccurs={0y+maxOccurs="1" />
<!--Number of DataChannels for each DataSources-->
<xs:plement name="NumPerOfDataChannel" type="xs:nonNegativelnteger"
minOgCurs="0" maxOccurs="1"/>
<!--B.4.2(6) Idéntifiers of target DataChannels-->
<xs:glement ndme="DataChannelID" type="sdt:DataChannelID"
minOccurs="0" maxOccurs="unbounded" />
<!--B.4.2 @)»DataSet structure -->
<xs:plement name="DataSet" type="sdt:DataSet Tabular"
minOccurs="0" maxOccurs="unbounded" />

</xs:sgguéence>
</xs:complexType>

<!--8.4.2(7) EventData structure -->
<xs:complexType name="EventData">
<xs:sequence>
<!--Number of DataSet elements under the hierarchy -->
<xs:element name="NumberOfDataSet" type="xs:nonNegativeInteger"
minOccurs="0" maxOccurs="1" />
<!--8.4.2(9) DataSet structure -->
<xs:element name="DataSet" type="sdt:DataSet Event"
minOccurs="0" maxOccurs="unbounded" />
</xs:sequence>
</xs:complexType>

<!--8.4.2(8) DataSet structure for Tabular Data -->
<xs:complexType name="DataSet Tabular">

32 © ISO 2018 - All rights reserved


https://standardsiso.com/api/?name=e2ddbc471cc9d5af12a4b3ee44601988

ISO 19848:2018(E)

<xs:sequence>
<!--Measurement value -->
<!--Measurement value can be empty-->
<xs:element name="Value" type="sdt:Value"
minOccurs="1" maxOccurs="unbounded"/>
</xs:sequence>
<!--IS0 8601 date & time structure shall be used-->
<xs:attribute name="timeStamp" type="xs:dateTime" use="required"/>
</xs:complexType>

<!--8.4.2(9) DataSet structure for Event Data-->
<xs:complexType name="DataSet Event">
<xs:sequence>

o . CLCICIIU TIdlllC= DdadldClldlllI©S L 1D LYPE= b.bLLing
minOccurs="1" maxOccurs="1"/>
<!--Measurement value -->

<!--Measurement value can be empty-->
<xs:element name="Value" type="xs:string"
minOccurs="1" maxOccurs="1"/>
/xs:sequence>
!--ISO 8601 date & time structure shall be used-->
<xs:attribute name="timeStamp" type="xs:dateTime" use="requixed"/>

xs:attribute name="quality" type="xs:string" use="optional!/>
</lxks:complexType>

<![--Value structure for Tabular Data -->
<¥s:complexType name="Value'">
xs:simpleContent>
<xs:extension base="xs:string">
<!--Ordinal number of the Value array.
Order of the array shall be the same ag~FabularData/DataChannellID array.f->
<xs:attribute name="ref" type="xs:positiveInteger" use="required" />
<xs:attribute name="quality" type="xS:string" use="optional"/>
</xs:extension>
/xs:simpleContent>
</lks:complexType>
</x9|: schema>

c) KML representation

F-xample of XML representdtion is as follows.

<?xml version="1.0" encoding="utf-8" 2>
<Padkage xmlns="urn:IS019848:SHIP DATA TRANSPORT">
<Header>
<ShipID>IM01234567</ShipID>
<TimeSpan>
<Start>2016-01-01T12:00:00Z</Start>
<End>207\6=01-03T12:00:00zZ</End>
</TimeSpan>
<DateCxeated>2016-01-03T12:00:00Z</DateCreated>
<DafteModified>2016-01-03T12:00:00Z</DateModified>
Buthor>Shipboard data server</Author>

QR PR NN APNCY TP T TR | PN
= T Pt +o+

<ID>SystemConfiguration.xml</ID>
<TimeStamp>2016-01-01T00:00:00Z</TimeStamp>
</SystemConfiguration>
<SystemConfiguration>
<ID>SystemConfiguration.xml</ID>
<TimeStamp>2016-01-03T00:00:00Z</TimeStamp>
</SystemConfiguration>
</Header>
<TimeSeriesData>
<DataConfiguration>
<ID>DataChannellist.xml</ID>
<TimeStamp>2016-01-01T00:00:00Z</TimeStamp>
</DataConfiguration>
<TabularData>
<NumberOfDataSet>2</NumberOfDataSet>
<NumberOfDataChannel>2</NumberOfDataChannel>
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<!--ShortID of the DataChannel -->
<DataChannelID id="1">0010</DataChannelID>
<DataChannelID id="2">0020</DataChannelID>
<DataSet timeStamp="2016-01-01T12:00:002">
<!--TabularData/DataSet/Value@ref references TabularData/DataChannelID@id -->
<!--measurement value of Data Channel:0010 at 2016-01-01T12:00:00Z -->
<Value ref="1" quality="0">100.0</Value>
<!--measurement value of Data Channel:0020 at 2016-01-01T12:00:00Z -->
<Value ref="2" quality="0">200.0</Value>
</DataSet>
<DataSet timeStamp="2016-01-02T12:00:002">
<!--measurement value of Data Channel:0010 at 2016-01-02T12:00:00Z -->
<Value ref="1" quality="0">100.5</Value>
<!__lllcd.bul_bﬂlbllh alluc€ OL Ddltd UlldllllIiEel . UUZU dUt ULOTULTU J.l . JU . UUL T T
<Vhlue ref="2" quality="0">205.0</Value>
</DafaSet>
</TabullarData>
<TabulprData>
<NumperOfDataSet>3</NumberOfDataSet>
<NumperOfDataChannel>1</NumberOfDataChannel>
<DatpChannelID id="1">0010</DataChannelID>
<DatpSet timeStamp="2016-01-01T12:00:002">
<Vhlue ref="1" quality="0">100.0</Value>
</DafaSet>
<DatphSet timeStamp="2016-01-02T00:00:002Z">
<Vhlue ref="1" quality="0">100.2</Value>
</DafaSet>
<DatpSet timeStamp="2016-01-02T12:00:002">
<Vhlue ref="1" quality="0">100.5</Value>
</DafaSet>
</TabularData>
<Eventpata>
<NumperOfDataSet>3</NumberOfDataSet>
<DatpSet timeStamp="2016-01-01T12:00:012" quality="0">
<DhtaChannelID>0011</DataChannelID>
<Vhlue>HIGH</Value>
</DafaSet>
<DatpSet timeStamp="2016-01-01T12:0Q0%612" quality="0">
<DhtaChannelID>0021</DataChannehID>
<Vhlue>HIGH</Value>
</DafaSet>
<DatpSet timeStamp="2016-01-QLTF12:00:23Z2" quality="0">
<DhtaChannelID>0011</Dat&4ChannelID>
<Vh1lue>NORMAL</Value>
</DafaSet>
</EvenfkData>
</TimeSefiesData>
<TimeSerfesData>
<DataCpnfiguration
<ID>pataChanngblist.xml</ID>
<TimpStamp>20136-01-03T00:00:00Z</TimeStamp>
</Datafonfiguration>
<TabulprData™>
<NumperOfDataSet>1</NumberOfDataSet>
<NumperOfDataChannel>2</NumberOfDataChannel>
<DataChannelID id="1">0010</DataChannelID>
<DataChannelID id="2">0020</DataChannelID>
<DataSet timeStamp="2016-01-03T12:00:002">
<Value ref="1" quality="0">101.0</Value>
<Value ref="2" quality="0">210.0</Value>
</DataSet>
</TabularData>
<TabularData>
<NumberOfDataSet>2</NumberOfDataSet>
<NumberOfDataChannel>1</NumberOfDataChannel>
<DataChannelID id="1">0010</DataChannelID>
<DataSet timeStamp="2016-01-03T00:00:002">
<Value ref="1" quality="0">100.8</Value>
</DataSet>
<DataSet timeStamp="2016-01-03T12:00:002">
<Value ref="1" quality="0">101.0</Value>
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</DataSet>
</TabularData>
TimeSeriesData>

</Package>

NOTE This example shows that both system configurations and Data Channel List are
2016-01-03T00:00:00Z, therefore this example has two Time Series Data elements. Further, Data Channel 0010,
0020 have 24 hour update interval and 0110 have 12 hour update interval. Therefore this example has two

Tabu

A3

larData elements for each TimeSeriesData element.

JSON implementation

8:2018(E)

modified at

A.3.
This
JSON

A.3.]
JSON

II/N

| General
clause defines the way to describe the data by using JSON.
implementation is not mandatory but shall be implemented in accordance with the fol
FExtension of the file shall be “json”.
Any newline or indent characters in the file shall not be treated assighificant informati

KML element with namespace shall convert to JSON elemient as it is. For exar
FElement>Value</xml:Element> is converted to { "xml:Elemetit" : "Value" }.

D Data Channel List

representation example is given below.

Package": {

"Header": {
"ShipID": "IMO1234567",
"DataChannelListID": {
"ID": "DataChannelList xml",

"TimeStamp": "2016-01—401T00:00:002"
by

"Author": "Authorl',
"DateCreated": "201%-12-01T00:00:002",
"nr:CustomHeadefE{ément": "Vender specific headers"

br
"DataChannelLigt' {
"DataChannpel®: [{
"DataGhannelID": ({
"LeCalID":
aming Rule/MainEngine/AirCoolerl/CoolingFreshWater/Outlet/Temp",
"ShortID": "0010",
"NameObject": {
"NamingRule": "Naming Rule",
"nr:CustomNameObject": "Vender specific NameObject"

}

owing.

Oo1.

hple, <xml:

by
"Property": {
"DataChannelType": {
"Type": "Inst",
"UpdateCycle": "1"
b
"Format": {
"Type": "Decimal",
"Restriction": {
"FractionDigits": "1",
"MaxInclusive": "200.0",
"MinInclusive": "-150.0"
}
b
"Range": {
"High": "150.0",
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"Low": "0.0"
by
"Unit": {
"UnitSymbol": "°C",
"QuantityName":
b
"QualityCoding":
"Name" :

"Remarks": " Location:

"nr:CustomPropertyElement":

}
boo A
"DataChannelID": {

LOCalllD

"Temperature"

"OPC QUALITY",
"M/E #1 Air Cooler CFW OUT Temp",

ECR, Manufacturer: AAA Company,

Type:
"Vender specific Property"

TYPE-AAA ",

"/Naming R
"ShortID": "0020",
"NameObject": {

"NamingRule":

}
by
"Property": {

"DataChannelType": {

"Type": "Average",
"UpdateCycle": "60",
"CalculationPeriod":
b
"Format": {
"Type": "Integer",
"Restriction": {
"FractionDigits":
"MaxInclusive":
"MinInclusive":
}
b
"Range": {
"High":
"Low":

"150.0",
"0.0"

b

'Unit": {
": "°c",
"QuantityName":

"UnitSymbo
" Temp AL}

"Name" :

"Remarks": "W Location:

}

oA

"DataChdannelID": {
"LdcalID":

"/Naming R

YShortID": "0011",

"NameObject": {
"NamingRule":

11le/MainEngine/AirCoolerl/CoolingFreshWater/Outlet/Press",

"Naming Rule",
"nr:CustomNameObject": "Vender specific NameObject"

"200.0",
"-150.0"

’
'QualityCoding": "OPC_QUALITY",
" M/E(#l+Air Cooler CFW OUT Average Temp ",

ECR, Manufacturer:
"nr:CustomPrOpertyElement':

hle/MadnkEngine/AirCoolerl/CoolingFreshiWater/Outlet/Temp/Alert",

"Naming_Rule",

"3I600"

"l",

AAA Company,

Type:
"Vender specific Property"

TYPE-AAA "

"nr:CustomNameObject":
}
I
"Property": {
"DataChannelType": {
"Type": "Alert"
by
"Format": {
"Type" . "String" ,
"Restriction": {
"Enumeration": [
"High",
HLOWH,
"Normal"

36

"Vender specific NameObject"
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b

"QualityCoding": "OPC QUALITY",
"Name": " M/E #1 Air Cooler CFW OUT Temp Status ",
"Remarks": " Location: ECR, Manufacturer: AAA Company, Type: TYPE-AAA ",
"nr:CustomPropertyElement": '"Vender specific Property"

}
boo A
"DataChannelID": {

"LocalID":
"/Naming Rule/MainEngine/AirCoolerl/CoolingFreshWater/Outlet/Press/Alert",
"ShortID": "0021",
"NameObject": {
"NamingRule": "Naming Rule",
I . CU LUHUVGUHC‘UUJ’ cCl . VvCIIUcCL bldc‘(,_ili’b llel[C'UUJ' cCl

}
by
"Property": {
"DataChannelType": {

"Type": "Alert"
by
"Format": {
"Type": "String",
"Restriction": {
"Enumeration": [
"High",
"Low",
"Normal"
]
}
br
"QualityCoding": "OPC QUALITY",
"Name": " M/E #1 Air Cooler CFW~\OUT Press Status ",
"Remarks": " Location: ECR, Mahufacturer: AAA Company, Type: TYPE-AAA ",
"nr:CustomPropertyElement" :~IVender specific Property"
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A.3.3 Time Series Data

Example of JSON representation is as follows.

{
"Package": {
"Header": {
"ShipID": "IMO1234567",
"TimeSpan": {
"Start": "2016-01-01T12:00:002",
"End": "2016-01-03T12:00:00z2"
b
"DateCreated": "2016-01-03T12:00:002",
"DateModified": "2016-01-03T12:00:00z",
"Author": "Shipboard data server",
"BystemConfiguration": [{
"ID": "SystemConfiguration.xml",
"TimeStamp": "2016-01-01T00:00:002"
2
"ID": " SystemConfiguration.xml ",
"TimeStamp": "2016-01-03T00:00:002"
}
bo
"TimgSeriesData": [{
"DataConfiguration™: {
"ID": "DataChannelList.xml",
"TimeStamp": "2016-01-01T00:00:00Z "
}
"lNabularData": [{
"NumberOfDataSet": "2",
"NumberOfDataChannel": "2",
"DataChannelID": ["0010", "0020"],
"DataSet": [{

"TimeStamp": "2016-01-01T12:00:00%%,
"Value": [ "100.0"™, "200.0" L,
HQualityH: [HO", "O"]

boo A

"TimeStamp": "2016-01-02T12:00:002",
"Value": [ "100.5", »285.0" 7,
"Quality": [uovv, non]

}]

oA
"NumberOfDataSet": M3%
"NumberOfDataChanne®¥: "1",
"DataChannelID".\ [)0110"],
"DataSet": [{

"TimeStamp3  "2016-01-01T12:00:00z2",
"Valde": [ "100.0"™ 7],

"Quality": ["0"]
b Ao
"TimeStamp": "2016-01-02T00:00:002",
"Value": [ "100.2" ],
"Quality": ["0"]
¥y |
J.J_llchL,dl[lp . ULOTULTU I L «UU . UUZL I3
"Value": [ "100.3" ],
"Quality": ["0"]
H
Pl
"EventData": {
"NumberOfDataSet": "3",
"DataSet": [{
"TimeStamp": "2016-01-01T12:00:01z2",
"DataChannelID": "0011",
"Value": "HIGH",
"Quality": "O"
boo A
"TimeStamp": "2016-01-01T12:00:012",
"DataChannelID": "0021",
"Value": "HIGH",
"Quality": "O"
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boo A
"TimeStamp": "2016-01-01T12:00:232",
"DataChannelID": "0011",
"Value": "NORMAL",
"Quality": "O"
H
}
boo A
"DataConfiguration": {
"ID": "DataChannelList.xml",
"TimeStamp": "2016-01-03T00:00:00z"
bo

"TabularData": [{

NUINPDELUL DAdlLadoCl . 1 I3
"NumberOfDataChannel": "2",
"DataChannelID": (["0010", "0020"],
"DataSet": [{

"TimeStamp": "2016-01-03T12:00:00Z2 ",
"Value": [ "101.0", "210.0" 7,

"Quality": ["0", "O"]
H]
P A
"NumberOfDataSet": "2",
"NumberOfDataChannel": "1",
"DataChannelID": ["0110"],

"DataSet": [{
"TimeStamp": "2016-01-03T00:00:002",
"Value": ["100.8"],
"Quality": ["0"]
b A
"TimeStamp": "2016-01-03T12:00:0024",

"Value": [ "101.0" ],
"Quality": ["O0"]
3]
H
H
}
}
NOTE Same as XML implementation, this example shows that both system configuration and Pata Channel

List 4re modified at 2016-01-03T00:00:00Z. Therefore, this example has two Time Series Data elemgnts. Further,
Data|Channel 0010, 0020 have 24<hour update interval and 0110 have 12-hour update interval. Therefore, this
exanjple has two TabularData elements for each TimeSeriesData element.

A.4| CSVimplementation

A.4.1 General

This|clause défines the way to describe the data by using CSV. CSV is only available for Time|Series Data
and phall betused in combination with Data Channel List described in XML/JSON.

CSV shall'be implemented in accordance with the following.

— CSV shall be described in accordance with RFC 4180.

— Extension of the file shall be “csv”.

— Tabular Data and Event Data shall be described separately.
— (CSV shall have the same number of columns in all rows.

— Header row (1st row) may be omitted when Data Channel in the data can clearly identified. This
definition will be described in Alias List on ISO 19847.

A.4.2 Tabular Data

CSV describes Tabular Data as follows:
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TimeStamp, DataChannellID 1, DataChannellID 2, ey DataChannelID N
TimeStamp 1, Value 1-1, Value-1-2, ey
. ey ey ey
TimeStamp M, ey ey ey Value M-N
where
TimeStamp_M is the measurement date and time;

DataChpnnellD_N is the one of the following: Universal ID, Local ID, Short ID;
Value_ M-N is the measurement value of DataChannellD_N at TimeStamp_M.

Example of CSV for Tabular Data by using Short ID is as follows:

TimeStamp, 0010, 0020

2016-01-01T12:00:00%Z, 100.0, 200.0
2016-01-02T712:00:00%Z, 100.5, 205.0
2016-01-9¢3T12:00:00%Z, 101.0, 210.0

where 0010, 0020 is the Short ID of some Data Channel.

A4.3 Evyent Data

CSV describes Event Data as follows:

TimeStamp, DataChannelID, Value
TimeStamp 1, DataChannelID~1y Value 1-1
ey ey
TimeStamp M, DataChannelID N, Value M-N
where

TimeStqmp_M isthe measurement date and time;

DataChpnnellD_]N- is the one of the following: Universal ID, Local ID, Short ID;

Value_M-N is the measurement value of DataChannellD_N at TimeStamp_M.

Example of CSV for Event Data by using Short ID is as follows:

TimeStamp, DataChannellID, Value
2016-01-01T12:00:01z,0011, HIGH
2016-01-01T12:00:01z,0021, HIGH
2016-01-01T12:01:23Z,0011, NORMAL

where 0011, 0021 is the Short ID of some Data Channel.
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Annex B
(informative)

Examples of Local ID definitions — jsmea_mac

B.1_Naming Rule

Locdl ID shall be named in accordance with rules that are unified respectively in each Naming Rule.

As ah example of jsmea_mac Naming Rule, a method of naming Local ID by dividing Data intio five Name
Objelcts and combining these IDs is introduced.

Detgils of Name Object are shown in Table B.1.

Table B.1 — List of Categories

Name Object Description < O Example
MainEngine,
Systlem Discrete equipment, systems, and units. DieselGeneraforSet
CoolingSeaWhterSystem
Cylinder
Comjponent Part of the System above or detail:description of the system. TurboChargef
FuelOilLine
HeavyFuelOi
Content Contents that flow throtigh pipelines or parts in the above CoolingFreshiWater
component.
ExahstGas
Inlet
Posittion Position thatindicates relative positions in System and Com- Outlet
ponents.
Port
Temp
Indicates temperatures, pressures and other measurement
[ten / Press
objects.
Speed
Only if Data Channels cannot be specified with the Elements Modifier is tyjpically used
shown above (from “System” to “Item”), suffix may be added to describe cqgrrection
Sufffx after Local ID to identify the Data Channels. parameter sulch as tem-
Option T T pet atareforfuel oil vis-
(Option] Suffix may consists of and DataChannelType as shown below. cosity, like "at15degC" .
Suffix: ../<modifier>/<DataChannelType>

» o«

According to the categorising and naming rules defined by “jsmea_mac”, “Main Engine #3 Air Cooler
Cooling Fresh Water Outlet Temperature” for the ship whose IMO number is “IM01234567” is as follows.

Local Data Name

ShipID Naming Rule =
System Component Content Position | Item

IM01234567 jsmea_mac MainEngine |AirCooler3 CoolingFreshWater Outlet Temp

In this case, the <Universal ID> and <Local ID> are as follows.
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<Universal ID> = http://IM01234567/jsmea_mac/MainEngine/AirCooler3/CoolingFreshWater/Outlet/

Temp//Inst

<Local ID> = /jsmea_mac/MainEngine/AirCooler3/CoolingFreshWater/Outlet/ Temp//Inst

B.2 Name Object

When writing Local ID structure in Data Channel List, Name Object is added under Data Channel

element.

Figure B.1 shows an example of adding Name Object in “jsmea_mac”. In this example, three attributes

—ID, Code g

1 DL A | o1 | DL Olea . | - | R RRA |
NU INAITIT— 4dI'T dAUUTU UITUCT INdITIT UUJTUL LU UTSLTTUT UTLAILS.

Package
1 Header
1
DataChannelList
1

DataChannel

0.*

Property

NameObject

NamingRule : String
jm:System : jm:System

jm:Component : jm:Component

jm:Content : jm:Content
jm:Position: jm:Position
jm:Item : jm:Item
jm:Suffix : jm:Suffix

jm:System

Vi

ID : String
Code : String
Name : String

jm:Component

V.

ID : String
Code : String
Name : String

jm:Content

V.

ID : String
Code : String
Name : String

jm:Position

Vi

ID : String
Code : String
Name : String

jm:Item

Vi

ID : String
Code : String
Name : String

jm:Suffix

I L L O L

Vi

ID : String
Code : String
Name : String

Figure B.1 — Logical structure of Data Channel List to which Name Object is added
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Codebook s alist of standard names that corresponds to Name Object, and created for each Name Object.

In codebook: ID, which is part of Local ID; Code, machine-friendly name that corresponds to the ID;
Name, that is for human readability; and its description are described.

EXAMPLE
ID Code Name Description
MainEngine 1IMEO1 No.1 Main Engine No. 1 Diesel engine for propulsion
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Annex C
(informative)

Examples of LocallD definitions — DNVGL-VIS

C.1 General

The requirgments regarding construction and contents of Local IDs under the DNVGL-VIS naming r‘llle is
provided at|data.dnvgl.com/dnvgl-vis. The purpose of this informative Annex is to provide explandtory
informatior] and examples to assist implementers.

C.2 DNV[GL-VIS introduction

VIS is an apbreviation for Vessel Information Systems, which has been usediin DNV GL produgtion
tools for classification of vessels since 2005. VIS contains a hierarchy of‘functions and librari¢s of
equipment,|where a name and code is defined for each item. The coding’is based on the Universal
Decimal Clgssification (UDC) numbering system. The DNVGL-VIS is fufther described in documentgtion
available at|data.dnvgl.com/dnvgl-vis.

C.3 Local ID construction

C.3.1 Ovgrall Local ID composition

When DNVGL-VIS is used as naming rule, the Local 1D shall be constructed as follows:

Local ID = Hunction group/n*Sub-Function group/Suffix and quantity group, where n is an integer [0 to
many) dengting how many times the Sub-Funétion group is repeated.

The naming elements within each graup shall be separated by a plus character (“+”), whereas ach
group shall|be separated by a slashcharacter (“/”).

Example of Local ID using DNVGL-VIS:

— 411.1/4101.31+2/ExhaustGasOut+t(C) (Coded version)

— PropulgionEnginef€ylinderArrangement+No2/ExhaustGasOut+t(C) (Verbose version)

NOTE Flirther &xplanation of this and other examples are provided in C.4. below.

In order to pvoid ambiguities for parser implementations, any space, plus or slash characters founpd in
the naming eterre ources {DNVEEHSoriS6-86600 reptced-bv-udersToTe ()

before constructing the Local ID.

C.3.2 Naming Elements groups

Three different Naming Elements groups are defined in the following:

a) Function group

Function group = <Function>+<Component>+<Location>

The Function group is mandatory and must start with one Function. The Component shall not
be included if a Sub-Function group is appended. (This is because the same Component will be
provided with the Sub-function at the next, and is thus redundant.) Although optional, it is highly

44 © ISO 2018 - All rights reserved


http://data.dnvgl.com/dnvgl-vis
http://data.dnvgl.com/dnvgl-vis
https://standardsiso.com/api/?name=e2ddbc471cc9d5af12a4b3ee44601988

b) Sub-Function group

ISO 1984

8:2018(E)

recommended that Location is used to separate between multiple instances of the given Function/
Component pair, when applicable.

Sub-Function group = <Sub-function>+<Component>+<Location>

0 to n Sub-Function groups can be appended to the Function group. Each Sub-Function group must
start with a Sub-Function. The Component is optional and may only be included in the last Sub-
Function group. Although optional, it is highly recommended that Location is used to separate
between multiple instances of the given Sub-Function/Component pair, when applicable.

Components assigned to a Function or Sub-Function can only be selected from those defined in VIS.
c) Ppuffix and quantity group
buffix and quantity group = <Suffix>+<Quantity>(<UoM>)
[he Suffix and quantity group is mandatory, but the individual elements\(Suffix, Quantity, UoM) are
bptional. This implies that at least one of the elements must be used.(The implementer nust ensure
that the Suffix and quantity group is constructed so that unique Loeal IDs are created.
The |different Naming Elements that can be used to construct the above Naming Element groups have
beer] further explained in Table C.1 below.
Table C.1 — Table C.1: Naming Elements used in DNVGL-VIS
Naming Element Péscription/Example
Functions represent the ability to perform or prevent certain actions by pprts of a ves-
Funktion sel. Functions are defined hierarchically. Function leaves may be assigned fomponents.
i The allowed Functionsvalues are defined in “DNVGL-VIS Functions”. Exqmples: 411.1
(Propulsion driver), 510 (Main electric power system)
Components are physical items that may exist on-board vessels. Componenfs are organ-
ized according to “Disciplines” defined in “DNVGL-VIS Disciplines”. Com][onents may
Compponent provide a detailed description through sub-functions, which again may|be assigned
Components. The allowed Component values are defined in “DNVGL-VIS Equipment”.
Examples»C221 (Shaft), C101 (Reciprocating internal combustion engine), N52 (Gyro compass)
Locations refer to positions on-board a vessel. Three types of Locations|are defined;
Lochtion absolute, generic and relative. The allowed Location values are defined in['DNVGL-VIS
Locations”. Location may be omitted if not needed to identify the Function or $ub-Function
group, e.g. if there is only one instance on-board. Examples: S (Starboard), F (Port), 1,2,9
Sub-Functions express the ability to perform or prevent actions applicable by parts
of a Component. Sub-functions are defined hierarchically. Sub-function ldaves may be
Sub{Function assigned Components. The allowed Sub-function values are defined in [[DNVGL-VIS
Equipment”. Examples: C101.31 (Cylinder arrangement in a Reciprocating ipnternal com-
bustion engine), E15.3 (Transformer in a Shore Connection)
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